
 

 

Video Intercom Indoor Station 

 
User Manual 

UD02905B 



  

Video Intercom Indoor Station·User Manual 

i 

 

User Manual 

© 2016 Hangzhou Hikvision Digital Technology Co., Ltd.  

 

This user manual is intended for users of the models below: 

 

Series Model 

Indoor Station (6-Series) 

DS-KH6310-W 

DS-KH6310 

DS-KH6310-WL 

DS-KH6210-L 

Indoor Station (8-Series) 

DS-KH8301-WTS 

DS-KH8301-WT 

DS-KH8300-T 

 

It includes instructions on how to use the Product. The software embodied in the 
Product is governed by the user license agreement covering that Product. 

 

About this Manual 

This Manual is subject to domestic and international copyright protection.  Hangzhou 
Hikvision Digital Technology Co., Ltd. (“Hikvision”) reserves all rights to this manual. This 
manual cannot be reproduced, changed, translated, or distributed, partially or wholly, by 
any means, without the prior written permission of Hikvision.  

 

Trademarks 

 and other Hikvision marks are the property of Hikvision and are 
registered trademarks or the subject of applications for the same by Hikvision and/or its 
affiliates. Other trademarks mentioned in this manual are the properties of their 
respective owners. No right of license is given to use such trademarks without express 
permission. 

 

Disclaimer 

TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, HIKVISION MAKES NO WARRANTIES, 
EXPRESS OR IMPLIED, INCLUDING WITHOUT LIMITATION THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, REGARDING THIS MANUAL. 

HIKVISION DOES NOT WARRANT, GUARANTEE, OR MAKE ANY REPRESENTATIONS REGARDING THE 
USE OF THE MANUAL, OR THE CORRECTNESS, ACCURACY, OR RELIABILITY OF INFORMATION 
CONTAINED HEREIN. YOUR USE OF THIS MANUAL AND ANY RELIANCE ON THIS MANUAL SHALL BE 

WHOLLY AT YOUR OWN RISK AND RESPONSIBILITY.  
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TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, IN NO EVENT WILL HIKVISION, ITS 

DIRECTORS, OFFICERS, EMPLOYEES, OR AGENTS BE LIABLE TO YOU FOR ANY SPECIAL, 
CONSEQUENTIAL, INCIDENTAL, OR INDIRECT DAMAGES, INCLUDING, AMONG OTHERS, DAMAGES 
FOR LOSS OF BUSINESS PROFITS, BUSINESS INTERRUPTION, SECURITY BREACHES, OR LOSS OF DATA 

OR DOCUMENTATION, IN CONNECTION WITH THE USE OF OR RELIANCE ON THIS MANUAL, EVEN IF 
HIKVISION HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.  

 

SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR LIMITATION OF LIABILITY OR CERTAIN 
DAMAGES, SO SOME OR ALL OF THE ABOVE EXCLUSIONS OR LIMITATIONS MAY NOT APPLY TO YOU. 

 

Support 

Should you have any questions, please do not hesitate to contact your local dealer. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

0104001060827 
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Regulatory Information 

FCC Information 

Please take attention that changes or modification not expressly approved by the party 
responsible for compliance could void the user’s authority to operate the equipment. 

FCC compliance: This equipment has been tested and found to comply with the limits 
for a Class A digital device, pursuant to part 15 of the FCC Rules. These limits are 
designed to provide reasonable protection against harmful interference when the 
equipment is operated in a commercial environment. This equipment generates, uses, 
and can radiate radio frequency energy and, if not installed and used in accordance with 
the instruction manual, may cause harmful interference to radio communications. 
Operation of this equipment in a residential area is likely to cause harmful interference 
in which case the user will be required to correct the interference at his own expense. 

FCC Conditions 

This device complies with part 15 of the FCC Rules. Operation is subject to the following 
two conditions: 

1. This device may not cause harmful interference. 

2. This device must accept any interference received, including interference that may 
cause undesired operation. 

EU Conformity Statement 

This product and - if applicable - the supplied accessories too are 
marked with "CE" and comply therefore with the applicable harmonized 
European standards listed under the EMC Directive 2004/108/EC, the 
RoHS Directive 2011/65/EU.  

2012/19/EU (WEEE directive): Products marked with this symbol cannot 
be disposed of as unsorted municipal waste in the European Union. For 
proper recycling, return this product to your local supplier upon the 
purchase of equivalent new equipment, or dispose of it at designated 
collection points. For more information see: www.recyclethis.info 

2006/66/EC (battery directive): This product contains a battery that 
cannot be disposed of as unsorted municipal waste in the European 
Union. See the product documentation for specific battery information. 
The battery is marked with this symbol, which may include lettering to 
indicate cadmium (Cd), lead (Pb), or mercury (Hg). For proper recycling, 
return the battery to your supplier or to a designated collection point. 
For more information see: www.recyclethis.info 

Industry Canada ICES-003 Compliance 

This device meets the CAN ICES-3 (A)/NMB-3(A) standards requirements. 

 

http://www.recyclethis.info/
http://www.recyclethis.info/
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Safety Instruction 

These instructions are intended to ensure that user can use the product correctly to 
avoid danger or property loss. 

The precaution measure is divided into Warnings and Cautions: 

Warnings: Neglecting any of the warnings may cause serious injury or death. 
Cautions: Neglecting any of the cautions may cause injury or equipment damage. 

 

 

 

 

 

 Warnings 
All the electronic operation should be strictly compliance with the electrical safety 
regulations, fire prevention regulations and other related regulations in your local 
region. 

Please use the power adapter, which is provided by normal company. The power 
consumption cannot be less than the required value. 

Do not connect several devices to one power adapter as adapter overload may cause 
over-heat or fire hazard. 

Please make sure that the power has been disconnected before you wire, install or 
dismantle the device. 

When the product is installed on wall or ceiling, the device shall be firmly fixed.  

If smoke, odors or noise rise from the device, turn off the power at once and unplug the 
power cable, and then please contact the service center. 

If the product does not work properly, please contact your dealer or the nearest service 
center. Never attempt to disassemble the device yourself. (We shall not assume any 
responsibility for problems caused by unauthorized repair or maintenance.) 

 Cautions 
Do not drop the device or subject it to physical shock, and do not expose it to high 
electromagnetism radiation. Avoid the equipment installation on vibrations surface or 
places subject to shock (ignorance can cause equipment damage). 

Do not place the device in extremely hot (refer to the specification of the device for the 
detailed operating temperature), cold, dusty or damp locations, and do not expose it to 
high electromagnetic radiation. 

The device cover for indoor use shall be kept from rain and moisture. 

Exposing the equipment to direct sun light, low ventilation or heat source such as heater 
or radiator is forbidden (ignorance can cause fire danger). 

  

Warnings Follow 
these safeguards to 
prevent serious 
injury or death. 

Cautions Follow these 
precautions to prevent 
potential injury or 
material damage. 
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Do not aim the device at the sun or extra bright places. A blooming or smear may occur 
otherwise (which is not a malfunction however), and affecting the endurance of sensor 
at the same time. 

Please use the provided glove when open up the device cover, avoid direct contact with 
the device cover, because the acidic sweat of the fingers may erode the surface coating 
of the device cover. 

Please use a soft and dry cloth when clean inside and outside surfaces of the device 
cover, do not use alkaline detergents. 

Please keep all wrappers after unpack them for future use. In case of any failure 
occurred, you need to return the device to the factory with the original wrapper. 
Transportation without the original wrapper may result in damage on the device and 
lead to additional costs. 

Improper use or replacement of the battery may result in hazard of explosion. Replace 
with the same or equivalent type only. Dispose of used batteries according to the 
instructions provided by the battery manufacturer. 
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1 Overview 

1.1 Introduction 
The video intercom system can realize functions such as video intercom, 

resident-to-resident video call, live view of HD video, access control, one-card system, 

elevator linkage, 8-ch zone alarm, notice information and visitor messages to provide a 

complete smart community video intercom system. 

The video intercom indoor station is mainly applied to situations such as community, 

villa, and official buildings. 

1.2 Main Features 
 Video intercom function 

 Remote unlocking function 

 Resident-to-resident audio call 

 Live view of HD video  

 Voice message function 

 Auto-respond and no disturbing mode 

 Noise suppression and echo cancellation 

 8-ch zone alarm and SOS calling function 

 Community notice 

 Convenient installation with the bracket, batch settings, and power over video/audio 

distributor (DS-KAD606, DS-KAD612) 
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2 Appearance 

2.1 Appearance of DS-KH8301-WTS/DS-KH8301-WT/ 
DS-KH8300-T 

 

Figure 2-1 Front Panel 

Table 2-1 Components Description 

No. Description 

1 Built-in Camera (Only 
DS-KH8301-WT supports) 

2 Power Supply Indicator 

3 Information Indicator 

4 Alarm Indicator 

5 SOS Touch Key 

6 Unlock Touch Key 

7 Live View Touch Key 

8 Management Center Touch Key 

9 LCD Display Screen 

10 Microphone 
 

 

Figure 2-2 Rear Panel 

Table 2-2 Components Description 

No. Description 

11 TF Card Slot 

12 Serial Port 

13 Mechanical Switch 

14 Power Supply Indicator 

15 Network Interface 

16 Loudspeaker 
 

 
 Hold down the SOS touch key to trigger a SOS alarm and upload the alarm message to 

the management center (iVMS-4200 client software or the master station). 

 The Unlock key ( ) is valid only when does the indoor station speak with the door 
station or open the live view of the door station. 
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2.2 Appearance of DS-KH6310-W/DS-KH6310 

 

Figure 2-3 Front Panel 

Table 2-3 Components Description 

No. Description 

1 Power Supply Indicator 

2 Information Indicator 

3 Alarm Indicator 

4 SOS Key 

5 Unlock Key 

6 Live View Key 

7 Management Center Key 

8 LCD Display Screen 

9 Microphone 
 

 

Figure 2-4 Rear Panel 

Table 2-4 Components Description 

No. Description 

10 Power Supply Interface 

11 Network Interface 

12 Terminals 

13 Loudspeaker 
 

 
 Hold down the SOS key to trigger a SOS alarm and upload the alarm message to the 

management center (iVMS-4200 client software or the master station). 

 The Unlock key ( ) is valid only when does the indoor station speak with the door 
station or open the live view of the door station. 
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2.3 Appearance of DS-KH6310-WL/DS-KH6210-L 

 

Figure 2-5 Front Panel 

Table 2-5 Components Description 

No. Description 

1 Power Supply Indicator 

2 Information Indicator 

3 Alarm Indicator 

4 SOS Key 

5 Unlock Key 

6 Live View Key 

7 Management Center Key 

8 LCD Display Screen 

9 Microphone 
 

 

Figure 2-6 Rear Panel 

Table 2-6 Components Description 

No. Description 

10 Power Supply 

11 Network Interface 

12 Terminals 

13 Loudspeaker 
 

 

 Hold down the SOS key to trigger a SOS alarm and upload the alarm message to the 

management center (iVMS-4200 client software or the master station). 

 The Unlock key ( ) is valid only when does the indoor station speak with the door 
station or open the live view of the door station. 

 For DS-KH6210-L indoor station, there are different meanings when you press or hold 

down the four mechanical keys.  
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Keys Hold Down Press 

 SOS Key Return Key 

  Direction Keys▲and◄/Unlock Key 

 Live View Key Alarm  Direction Keys▼and► 

 
Management Center Key Confirm Key 
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3 Typical Application 

Network Cable

Optical Fiber

One Resident

RS-485

Wi-Fi

PC Client

Center Master Station

Door Station

IPC

Master Station
In Guard's Room

Outer Door Station

Video/Audio
Distributor

Card 
Reader 

Card 
Reader

1F

Resident 1

2F

3F

4F

Video/Audio
Distributor

 LAN

Resident 2

Resident 1Resident 2

Resident 1Resident 2

Resident 1Resident 2

Indoor 
Extension 2

Indoor 
Extension 2

Building

App

 
Figure 3-1 Typical Application of Indoor Station 

 
Indoor extensions in a resident are in the same LAN with other devices in a video 
intercom system.  
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4 Terminals and Interfaces 

4.1 Terminals and Interfaces of DS-KH8301-WTS/ 
DS-KH8301-WT/DS-KH8300-T 

 
Figure 4-1 Terminals of DS-KH8301-WTS/DS-KH8301-WT/DS-KH8300-T 

Table 4-1 Descriptions of Terminals and Interfaces 

Name No. Interface Description 

485 
Communication 

Port 

A1 RS485B+ 

Reserved 
A2 RS485B- 

A3 RS485A+ 

A4 RS485A- 

Grounding 
A5 GND Grounding 

A6 GND Grounding 

ALARM OUT 
(Alarm Output) 

A7 COM1 
Alarm Relay Output Terminal 1 (Dry Contact) 

A8 NO1 

A9 COM2 
Alarm Relay Output Terminal 2 (Dry Contact) 

A10 NO2 

ALARM IN 
(Zone Input) 

B1 JIN8 Zone Detector Input Terminal 8 

B2 JIN7 Zone Detector Input Terminal 7 

B3 JIN6 Zone Detector Input Terminal 6 

B4 JIN5 Zone Detector Input Terminal 5 

B5 GND Grounding 

B6 GND Grounding 
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Name No. Interface Description 

B7 JIN4 Zone Detector Input Terminal 4 

B8 JIN3 Zone Detector Input Terminal 3 

B9 JIN2 Zone Detector Input Terminal 2 

B10 JIN1 Zone Detector Input Terminal 1 

4.2 Terminals and Interfaces of DS-KH6310-W/ 
DS-KH6310 

 
Figure 4-2 terminals of DS-KH6310-W/DS-KH6310 

Table 4-2 Descriptions of Terminals and Interfaces 

Name No. Interface Description 

Terminals 

A1 RS485- 
Reserved 

A2 RS485+ 

A3 AIN1 Zone Detector Input Terminal 1 

A4 AIN2 Zone Detector Input Terminal 2 

A5 AIN3 Zone Detector Input Terminal 3 

A6 AIN4 Zone Detector Input Terminal 4 

B1 AIN5 Zone Detector Input Terminal 5 

B2 AIN6 Zone Detector Input Terminal 6 

B3 AIN7 Zone Detector Input Terminal 7 

B4 AIN8 Zone Detector Input Terminal 8 

B5 AOUT Alarm Relay Output 

B6 GND Grounding 
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4.3 Terminals and Interfaces of DS-KH6310-WL/ 
DS-KH6210-L 

 
Figure 4-3 Terminals of DS-KH6310-WL/DS-KH6210-L 

Table 4-3 Terminals Description 

Name No. Interface Description 

Terminals 

A1 AIN1 Zone Detector Input Terminal 1 

A2 AIN2 Zone Detector Input Terminal 2 

A3 GND Grounding  
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5 Installation and Wiring 
Before you start: 

 Make sure the device in the package is in good condition and all the assembly parts 

are included. 

 The power supply the indoor station supports is 12 VDC. Please make sure your 

power supply matches your indoor station. 

 Make sure all the related equipment is power-off during the installation. 

 Check the product specification for the installation environment.  

5.1 Indoor Station Installation 
The wall mounting plate and the junction box are required to install the indoor station 
onto the wall. Junction boxes for 8-series and 6-series indoor stations are the same.  

5.1.1 Wall Mounting Plate 

60 mm
102 mm
127 mm

1
0

0
 m

m

2
7

 m
m

4
4

.5
 m

m
7

0
 m

m

 
Figure 5-1 Wall Mounting Plate 

 

The dimension of junction box should be 75 mm (width) × 75 mm (length) × 50 mm 

(depth). 

5.1.2 Wall Mounting with Junction Box 
Wall mounting installations are the same for the 6-series indoor stations and the 
8-series indoor stations. Here we take the wall mounting of DS-KH6310 model as an 
example. 
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Steps: 

1. Chisel a hole in the wall. The size of the hole should be 76 mm (width) × 76 mm 
(length) × 50 mm (depth). 

2. Insert the junction box to the hole chiseled on the wall.  

3. Fix the wall mounting plate to the junction box with 2 screws.  

Screws

Wall Mounting 
Plate

Junction Box

 
Figure 5-2 Install the Plate 

4. Hook the indoor station to the wall mounting plate tightly by inserting the plate hooks 
into the slots on the rear panel of the indoor station, during which the lock catch will 
be locked automatically. 

Hooks

Slot Slot

Lock Catch

 
Figure 5-3 Hook the Indoor Station to the Plate 
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5.2 Indoor Station Wiring 

5.2.1 Wiring of DS-KH8301-WTS/ DS-KH8301-WT/DS-KH8300-T 

 
Figure 5-4 Wiring of DS-KH8301-WTS/DS-KH8301-WT/DS-KH8300-T Indoor Station 
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5.2.2 Wiring of DS-KH6310-W/DS-KH6310 

 
Figure 5-5 Wiring of DS-KH6310-W/DS-KH6310 Indoor Station 
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5.2.3 Wiring of DS-KH6310-WL/DS-KH6210-L 

 
Figure 5-6 Wiring of DS-KH6310-WL/DS-KH6210-L Indoor Station 
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Descriptions of Indoor Station interfaces are shown in the following table. 

Interface Description 

ALARM IN Connect alarm device, with one end of the device connecting 
to JINx and the other end connecting to GND (x indicates 

number between 1~8). 

ALARM OUT Connect alarm output devices. 

GND 12V Connect to DC power supply 12V. 

LAN Network port of indoor station. Connect the indoor station to 
the same LAN with the door station. (Support POE) 
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6 Before You Start 
For the first time use of the device, you are required to activate the device and set the 

device password. You can activate the device on the UI, via internet with Batch 

Configuration Tool, or with iVMS-4200 client software.  

To activate the device on the UI, refer to 7 Local Operation. 

To activate the device with Batch Configuration Tool or iVMS-4200, refer 

to 8 Remote Operation via Batch Configuration Tool and 9 Remote 

Operation via iVMS-4200. 

To configure the key parameters of device on the user interface of indoor station, you 

are required to input the admin password. 

 The default admin configuration password is 888999.  

 The default unlocking password and arming/disarming password are 123456;  

 The default duress code is 654321.  

You must change these default credentials to protect against unauthorized access to the 

product. 
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7 Local Operation 

 

 Here the local operation of indoor stations with touch screen is taken as example.  

 The DS-KH6210-L should be operated with physical keys. The SOS key works as a 

return key; the Unlock key works as direction keys ▲and◄ to turn up and left; the 

Live View key works as direction keys ▼and► to turn down and right; and the 

Management Center key works as a confirm key.  

7.1 Activating Device Locally  

Steps: 
1. Power on the device to enter the activation interface automatically. 

  
Figure 7-1 Activation Interface (DS-KH8301-WT) 

2. Create a password and confirm it.  
3. Press the OK button to activate the device.  

 
STRONG PASSWORD RECOMMENDED– We highly recommend you to create a strong 

password of your own choosing (using a minimum of 8 characters, including 
at least three kinds of following categories: upper case letters, lower case 
letters, numbers, and special characters) in order to increase the security of 

your product. And we recommend you reset your password regularly, especially in the 
high security system, resetting the password monthly or weekly can better protect your 
product. 
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 You must create a password to activate the device for your first time usage and when 

it is not activated.  

 Only when the device is activated, can you operate it locally and remotely.  

 Here the activation interface of DS-KH8301-WT indoor station is taken as example.  

7.2 User Interface Description 

7.2.1 User Interface of Indoor Station  

 
Figure 7-2 User Interface of Indoor Station (Page 1) 

 
Figure 7-3 User Interface of Indoor Station (Page 2) 

 



  

Video Intercom Indoor Station·User Manual 

19 

 

 Slide left and right to realize the switch between two interface pages (except for 

DS-KH6210-L.  

 Here the user interface of DS-KH8301-WT is taken as as example. 

 Only DS-KH8301-WTS/DS-KH8301-WT/DS-KH8300-T indoor stations support TF card. 

 DS-KH6210-L only has one interface page. 

 
Figure 7-4 User Interface of DS-KH6210-L 

7.2.2 User Interface of Indoor Extension 

 
Figure 7-5 User Interface of Indoor Extension 

 

 Only DS-KH8301-WTS/DS-KH8301-WT/DS-KH8300-T indoor extensions support TF 

card. 

 Here the user interface of DS-KH8301-WT indoor extension is taken as example. 



  

Video Intercom Indoor Station·User Manual 

20 

 

7.2.3 Status of Indoor Station 

Table 7-1 Description of Status Icons 

Icon Definition Description 

 
Normal Status. 

The communication between indoor station, 
door station and master station is normal. 

And the communication between indoor 
station and indoor extension is normal.  

 

The indoor 
station is offline. 

Please check the network cable or Wi-Fi 
connection.  

 

Exception occurs 
in the 
communication 
with door 
station. 

Room No. conflict. Configure the Room No. 
again. 

Invalid Room No.. Configure the Room No.. 

Invalid main door station IP address. Configure 
the main door station IP address. 

Network of door station is abnormal. Check the 
network connection of main door station. 

Communication of door station is abnormal. 
Check if the door station IP address is correct. 

 

The indoor 
station has not 
registered in the 
SIP server.  

Invalid SIP server IP address. Set the SIP server 
IP address. 

Network of SIP server is not available. Check 
the SIP server network connection. 

SIP server communication is not available. 
Check if the SIP server IP address is correct. 

SIP server rejected to login the device. Check if 
the device No. has been registered. 

 

The indoor 
station IP 
address conflicts 
with that of 
other device.  

Please check the IP address.  

 

TF card is 
inserted in the 
indoor station. 

Only DS-KH8301-WTS/DS-KH8301-WT/ 
DS-KH8300-T Models support the TF card 
function. 
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Icon Definition Description 

 

Exception occurs 
with the TF card. 

 

No TF card is 
inserted in the 
indoor station. 

7.2.4 Status of Indoor Extension 

Table 7-2 Description of Status Icons 

Icon Definition Description 

 
Normal Status. 

The communication between indoor station 
and indoor extension is normal. 

 

The indoor 
extension is 
offline. 

Please check the network cable or Wi-Fi 
connection.  

 

The indoor 
extension IP 
address conflicts 
with that of 
other device.  

Please check the IP address.  

 

The indoor 
extension has 
not connected 
to the indoor 
station.  

Invalid indoor station IP address. Set the indoor 
station IP address. 

Network of indoor station is not available. 
Check the indoor station network connection. 

The indoor extension number conflicts with 
number of another indoor extension.  

 

TF card is 
inserted in the 
indoor station. 

Only DS-KH8301-WTS/DS-KH8301-WT/ 
DS-KH8300-T Models support the TF card 
function.  

Exception occurs 
with the TF card. 

 

No TF card is 
inserted in the 
indoor station. 
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7.2.5 Arming Status 

Purpose: 

4 kinds of scene modes are supported by the indoor station: Sleeping Mode, Indoor 
Mode, Outdoor Mode, and Custom Mode.  

You can arm or disarm your room in each scene mode manually. When your room is in 
the arming status, the arming status will display on the main interface of the indoor 
station. 

Arming Your Room 

Steps: 
1. Press the Arming Status tab to display the arming status interface.  

 
Figure 9-1 Pressing Arm Tab 

2. Press the Arm tab.  
3. Enter the arm password to enable the arming status.  
4. (Optional) Press a scene mode icon, and enter the arm password to change the scene 

mode of the indoor station.  
Example: After setting the arming status, press the Sleeping tab, and enter the arm 
password. The indoor station changes to the arming status of the sleeping mode and 
the interface will display as follow: 

 
Figure 9-2 Sleeping Mode 

Disarming Your Room 

1. Press the Arming Status tab to display the arming status interface. 
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Figure 9-3 Pressing Disarm Tab 

2. Press the Disarm tab. 
3. Enter the disarm password to enable the disarming status. 
4. (Optional) Press a scene mode icon, and enter the disarm password to change the 

scene mode of the indoor station. 

 

 Only one mode of arming can be set at one time. When you set another mode of 

arming status, the former one is disarmed automatically.  

 If enabling the arming status successfully, you can hear a voice prompt “armed”, and 

the corresponding arming status will display on the main interface.  

 If enabling the disarming status successfully, you can hear a voice prompt “disarmed”, 

and the corresponding disarming status will display on the main interface.  

 The DS-KH6210-L indoor station does not support this function. 

7.3 Indoor Station Settings 

Purpose: 

On the settings interface, you can set passwords (admin password, duress code, unlock 

password, and arm/disarm password), set the device sound, set no disturbing schedule, 

set the arming mode and zone, perform the system maintenance, set the configuration 

settings, and view the device information. 

7.3.1 Password Settings 

Purpose: 

 You can edit the admin password (configuration password), duress code, unlock 

password and arm/disarm password of the indoor station.  

 You can edit the admin password (configuration password) and arm/disarm password 

of the indoor extension.  

 Enter admin password when configuring key parameters.  
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 Enter duress code in the door station when the user is hijacked.  

 Enter unlock password in the door station when opening door of the building.  

 Enter arm/disarm password when arming/disarming the zone.  

Steps: 

1. Press the Settings tab on the touch screen to enter the password settings interface.  

 
Figure 9-4 Password Settings Interface (Indoor Station) 

 
Figure 9-5 Password Settings Interface (Indoor Extension) 

2. Press the Admin Password tab, Duress Code tab, Unlock Password tab, or 
Arm/Disarm Password tab to enter corresponding interfaces. 

3. Press the Edit tab to pop up the password changing dialogue box. 
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Figure 9-6 Password Changing Interface 

4. Enter the old password to change it 
5. Enter the new password and confirm it. 

6. Press the  tab to save the settings.  

STRONG PASSWORD RECOMMENDED– We highly recommend you to create a 
strong password of your own choosing (using a minimum of 8 
characters, including at least three kinds of following categories: 
upper case letters, lower case letters, numbers, and special characters) 
in order to increase the security of your product. And we recommend 

you reset your password regularly, especially in the high security system, resetting 
the password monthly or weekly can better protect your product. 

 

 

 The default admin password (configuration password) is 888999. 

 The default unlock password, arm/disarm password, and scene password are 123456.  

 The default duress code is 654321. 

 For Indoor Extension, only admin password and arm/disarm password are supported. 

7.3.2 Sound Settings 

Purpose: 

You can set the ringtone, ring duration, call forwarding time, volume of microphone and 

loudspeaker, enable/disable touch sound and auto-answer function on sound settings 

interface. 

Steps: 
1. Get to the sound settings interface: Settings -> Sound Settings.  
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Figure 9-7 Sound Settings Interface (Indoor Station) 

2. Set corresponding parameters.  
Ringtone: There are 3 ringtones by default, and you can custom and import at most 4 
ringtones via Batch Configuration Tool or iVMS-4200 Client Software.  
Ring Duration: The maximum duration of indoor station when it is called without being 
accepted. Ring duration ranges from 30s to 60s.  
Call Forwarding (Time): The ring duration limit beyond which the call is automatically 
forwarded to eh mobile phone designated by the resident. Call forwarding (time) 
ranges from 0s to 20s.  
Enable Auto-Answer: After enabling the auto-answer function, the visitor can leave 
the voice message to the indoor station from the door station, the master station, or 
the client software. 

 

 Auto-answer function is only available to 8-series indoor stations with TF card 

function and 6-series indoor stations. 

 For indoor extension, it does not support the ring duration settings, call forwarding 

settings, or auto-answer function.  
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Figure 9-8 Sound Settings Interface (Indoor Extension) 

7.3.3 No Disturbing Settings 

Purpose: 

Two types of no disturbing mode can be configured: All day and Scheduled. 

Steps: 
1. Get to the no disturbing settings interface: Settings -> No Disturbing. 

 
Figure 9-9 No Disturbing Settings Interface 

2. Select no disturbing mode: All Day or Scheduled. 
 All Day: 



  

Video Intercom Indoor Station·User Manual 

28 

 

1) Switch  to  to enable no disturbing mode.  
 Scheduled: 

1) Switch  to  to enable no disturbing mode.  
2) Set the start time and the end time.  

 
 Under all-day no disturbing mode, the indoor station will not ring all day when it is 

called by door station or other indoor stations, but the call logs will be saved.  

 Under scheduled no disturbing mode, the indoor station will not ring between the 

start time and the end time when it is called by door station or other indoor stations, 

but the call logs will be saved.  

 Indoor extension does not support No Disturbing Settings.  

7.3.4 Zone Settings 

Purpose: 

You can set the zone type, alarm type and delay time and other parameters of 8 zones. 

Steps: 
1. Get the zone settings interface: Settings -> Zone Settings. 

 
Figure 9-10 Zone Settings Interface 

2. Press a zone to pop up the zone editing dialogue box.  
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Figure 9-11 Zone Editing Interface 

3. Set the zone type, alarm type, status of arming status, entering delay, and exiting 
delay.  

4. Press the  tab to save the settings.  

 

 

 6 zone types are selectable: Panic Button, Door Magnetic, Smoke Detector, Active 

Infrared, Passive Infrared, and Gas Detector. 

 3 alarm types are selectable: 24h Alarm, Instant Alarm, and Delay Alarm. 

Set the alarm type as 24h alarm, and the zone will be armed for 24h. 

Set the alarm type as instant alarm, and the zone will alarm once it’s triggered.  

Set the alarm type as delay alarm, and you should set the entering delay 

duration and exiting delay duration. 

 Both the entering delay duration and the exiting delay duration are from 30s to 60s.  

 For Gas Detector and Smoke Detector, the alarm type is set as default 24h alarm. 

 The DS-KH6210-L and DS-KH6310-WL indoor stations only support 2 zones.  

7.3.5 Arming Mode Settings 

Purpose: 

4 arming modes can be configured: outdoor mode, indoor mode, sleeping mode and 

custom mode. 

Steps: 
1. Get to the arming mode settings interface: Settings -> Arming Mode  
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Figure 9-12 Arming Mode Settings Interface 

2. Press Outdoor Mode tab, Indoor Mode tab, Sleeping Mode tab, and Custom Mode 
tab to enter corresponding arming mode settings interface.  

3. Switch  to  to enable the arming in the selected zoon.  

 

 Zones in each arming mode can be configured manually. See detailed information in 

7.3.4 Zone Settings.  

 For 24H alarm zone and smoke detector zone, even if it is disabled under current 

arming mode, the indoor station will still alarm when it is triggered. 

 Arming mode settings should be configured with the settings of arming status on the 

the user interface of the device. 

 The DS-KH6210-L and DS-KH6310-WL indoor stations only support 2 zones.  

7.3.6 System Maintenance 

Purpose: 

You can format TF card, clear the screen, view the version information of the indoor 

station and reboot the system on the system maintenance interface.  

Steps: 
1. Get to the system maintenance interface: Settings -> Maintenance. 
2. Press the Format tab to format the TF card. 

3. Switch  to  to enable the clear screen mode.  
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4. Press the Reboot tab to reboot the system.  

 
Figure 9-13 System Maintenance Interface 

 

 Only DS-KH8301-WTS/DS-KH8300-T/DS-KH8301-WT indoor stations support TF card 

function.  

 After enabling Clear Screen function, press and hold the Unlock key ( ) to exit the 
clear screen mode. 

7.3.7 Configuration Settings  

Purpose: 
On the configuration settings interface, you can set and view the local information, 
configure the network, manage devices, synchronize the device time, and restore the 
default settings. 

Setting Local Information 

Steps: 

1. Get to the configuration interface: Settings > Configuration, and enter the admin 
password (configuration password). 

2. Press the Local Info tab, and select the indoor station type: Indoor Station, or Indoor 
Extension. 
Indoor Station: Set the Room No. 
Indoor Extension: Set the Extension No., and set a room name.  



  

Video Intercom Indoor Station·User Manual 

32 

 

 
Figure 7-6 Local Information Settings (Indoor Station) 

 
Figure 7-7 Local Information Settings (Indoor Extension) 

3. Press the drop-down list to select a video standard: PAL, or NTSC.  
4. Set the maximum live view duration of the device. 

 

 The Extension No. is numeric from 1 to 5, i.e., up to 5 indoor extensions can connect 

to one indoor station.  
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 Only DS-KH8301-WT, and DS-KH8301-WTS require setting the video standard, and the 

system will reboot after selecting video standard. 

 The maximum live view duration varies from 10 seconds to 60 seconds. 

Setting Network 

Purpose: 
Network connection is mandatory for the use of the indoor station.  

Steps: 

1. Get to the configuration interface: Settings > Configuration, and enter the admin 
password (configuration password). 

2. Press the Network tab to enter the network settings interface. 

 
Figure 7-8 Network Interface 

3. Press the  tab to pop up network settings dialogue box.  

  
Figure 7-9 Setting Network 

4. Enter a local IP address, subnet mask, and gateway.  

5. Press the  tab to save the settings.  
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 Enable DHCP function to obtain an IP address automatically.  

 Enable Same LAN function if indoor stations and indoor extensions are in the same 

local area network with other video intercom devices in a community, or the indoor 

extensions will not work normally. 

Setting the SIP Server 

Purpose: 

To realize the connection between the indoor station and the management center 
(master station), the indoor station should connect to a SIP server in advance.  

Steps: 

1. Get to the device management interface: Settings -> Configuration -> Device.  
2. Press the SIP Sever tab, and enter the IP address of the SIP server.  

3. Press the  tab to save the SIP server added. 

 

 The master station can work as a SIP server.  

 Indoor extension cannot connect to the SIP server.  

Adding Devices 

Purpose: 

The indoor station never works alone. You can connect the main door station, IP camera, 
SIP server, management center, master station, DVR/DVS/NVR, and so on. Once 
connected, those devices can work together as a whole video intercom system. 

 

 The DS-KH6210-L indoor station does not support adding IP camera, DVR/DVS/NVR, 

or doorphone.  

 Indoor Extension only supports adding indoor station.  

 Setting Center/Master Station (Optional) 

Steps: 

1. Get to the device interface: Settings -> Configuration -> Device. 
2. Press the Center or Master Station tab to pop up the device information dialogue 

box.  
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Figure 7-10 Center/Master Station Adding Interface (Indoor Station) 

3. Entering the IP address of center or the master station, and press the  tab to save 
the settings. 

 

 After setting center or the master station in the indoor station, the alarm messages 

will be uploaded to the center or the master station automatically.  

 You can edit but not delete the center or the master station in the device 

management interface. 

 Connecting Main Door Station 

Steps: 

1. Get to the device interface: Settings -> Configuration -> Device. 
2. Press the Main Door Station tab to pop up the device information dialogue box.  
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Figure 7-11 Main Door Station Adding Interface (Indoor Station) 

3. Select the main door station type: D Series, or V Series.  

4. Enter the IP address of the main door station, and press the  tab to save the 
settings.  

 

You can edit but not delete the main door station in the device management interface. 

 Adding IP Camera/DVR/DVS/NVR/Doorphone 

Steps: 

1. Get to the device management interface: Settings -> Configuration -> Device. 
2. Press the Add Device tab. 
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Figure 7-12 Device Selecting Interface (Indoor Station) 

3. Select a kind of device type, and enter corresponding information (device name, IP 
address, port No., password, etc.). 

4. Press the  tab to save the settings.  

 
 The default port No. is 554, and the default user name is admin.  

 Up to 8 doorphones can be added to the indoor station.  

 Up to 16 IP cameras and DVR/DVS/NVR in total can be added to the indoor station. 

 When the IP camera is added successfully, you can get the live view of IP camera on 

the live view interface. 

 The highest resolution of the IP camera added to the indoor station is 1280 x 720 @ 

30 fps, and the video compression standard of the IP camera should be H.264. 

Synchronizing Time 

Steps: 
1. Get to the time synchronizing interface: Settings -> Configuration -> Sync Time. 
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Figure 9-14 Time Synchronizing Interface 

2. Switch  to  to enable NTP. 
3. Set the synchronizing interval, enter the IP address of NTP server and port No., and 

select the time zone. 

 

 The default unit of synchronizing interval is minute. 

 The default port No. is 123. 

Restoring and Upgrading Device 

Steps: 
1. Get to the device restoring and upgrading interface: Settings -> Configuration -> 

Restore. 
2. Press the RESTORE button to restore the default settings and reboot the system. 
3. Press the UPGRADE button to upgrade the indoor station online. 
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Figure 9-15 Device Restoring and Upgrading 

 

Only DS-KH8301-WTS/DS-KH8301-WT/DS-KH6310-W/DS-KH6310-W(T) indoor stations 

support online upgrading.  

7.4 Call Settings 

7.4.1 Adding Contact 

Steps: 

1. Press the  tab on the user interface to enter the contact list interface. 
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Figure 9-16 Contact List Interface 

2. Press the Add Contact tab to pop up the contact adding dialogue box.  
3. Enter the name and room number of the contact.  

4. Press the  tab to save the settings.  

 

 Hold down an added contact to open the contact handling menu.  

 

 Press the Call tab to start the video call with the contact. 

 Press the Edit tab to modify the contact information.  

 Press the Delete tab to delete the contact.  

 Press the Clear tab to delete all contacts added in the indoor station.  

 Indoor extension does not support this function.  

 The DS-KH6210-L does not support this function.  

7.4.2 Calling Resident 
Steps: 
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1. Press the  tab on the touch screen to enter the residents calling 
interface.  

2. Enter the corresponding resident’s Room No..  

3. Press the  tab to start an audiovisual call.  

4. Press the  tab to stop the audiovisual call.  

 

 Generally speaking, Room No. format should be like 1-2-3-405 as Community 1, 

Building 2, Unit 3, and Room 405. The community No. can be omitted.  

 Switch  to  on the upper right corner to enable the camera function.  
 The Room No. can be automatically saved into the contact list. 
 Indoor extension does not support this function.  
 On the call resident interface of DS-KH6210-L, there is no Contact List, Call Elevator, 

or Call Center tab. 

 
Figure 7-13 Call Resident Interface 

7.4.3 Calling Management Center 

2 options are selectable to call management center.  

Option 1: 

Press the tab  on the main interface of the indoor station.  

Option 2: 
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Press the tab  on the speaking interface or the live veiw interface.  

 

 Management center here refers to the master station and iVMS-4200 client software.  

 For indoor extension, it only supports calling the master station.  

7.4.4 Receiving Call 

Purpose:  
The indoor station can receive calls from the door station, the master station, or 
iVMS-4200 client software.  

 
Figure 9-17 Call from Center (Master Station or iVMS-4200) 
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Figure 9-18 Call from Door Station 

 

 On the call from door station interface, press the Unlock tab, the building door will 

open.  

 Press the  tab to capture the live view picture when speaking with the door 
station. And prompts “Captured” will display on the screen.  

 Indoor extension can receive the call from the door station and the master station 
only. 

7.4.5 Viewing Call Logs 
Steps: 

1. Press the  tab on the touch screen to enter the call log interface.  
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Figure 9-19 Call Logs Interface  

2. Press tab Missed Call or All Calls to view missed call logs or all call logs.  

 

 Indoor extension does not support this function.  

 The indoor station saves call logs from door station, outer door station, management 

center and other indoor stations. 

 Hold down a piece of call log to open the call log handling menu.  

 

 Press the View tab to enter the live view interface.  

 Press the Delete tab to delete the piece of call log.  

 Press the Clear tab to delete all pieces of call logs.  

 For the DS-KH6210-L, select a piece of call log and press the Confirm key to pop up 

the captured picture.  

7.5 Live View 
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 Make sure the IP camera or door station is well-connected.  

 Make sure the indoor extension and the indoor station are well-connected.  

 The DS-KH6210-L indoor station does not support the live view of IP camera.  

Purpose: 
On the live view interface, you can monitor the live view of added door station and IP 
camera.  

Steps: 
1. Press the Live View tab on the user interface to enter the live view interface. 

 
Figure 9-20 Live View Interface 

2. Press the Door Station tab to enter the live view interface of door station.  
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Figure 9-21 Live View of Door Station 

3. Press the IP Camera tab to enter the live view interface of IP cameras.  

 
Figure 9-22 Live View of IP Camera 

 

On the door station live view interface, press the Unlock tab to open the unit door. 

7.6 Information Management 

You can view public notice, visitor message, alarm log and capture log on information 

management interface.  

Press the  tab or the  tab to enter the information 
management interface. (Here take the alarm log interface as example.) 
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Figure 9-23 Alarm Logs Interface (Indoor Station) 

 

 Indoor extension only supports alarm log and capture log.  

 For DS-KH8301-WTS/DS-KH8301-WT/DS-KH8300-T models, it requires TF card for 

saving the notice, visitor messages and capture logs of the indoor stations, and 

requires the internal memory of the indoor station to save the alarm log.  

 For DS-KH6310/DS-KH6310-W/DS-KH6310-WL/DS-KH6210-L models, it is the internal 

memory of the indoor station that saves the notice, visitor messages, alarm logs, and 

capture logs. 

 Up to 200 pieces of notice, 200 pieces of visitor messages, 200 pieces of alarm logs, 

and 200 pieces of capture logs can be saved. 

 Hold down the item to delete or clear all items on each interface.  

 On the alarm log interface (indoor station), hold down the piece of the alarm log to 

open the alarm details interface.  
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8 Remote Operation via Batch 
Configuration Tool 
You can configure and operate the video intercom devices via Batch Configuration Tool.  

Default parameters of indoor station are as follows: 

 Default IP Address: 192.0.0.64. 

 Default Port No.: 8000. 

 Default User Name: admin. 

8.1 Activating Device Remotely 
Purpose 

You are required to activate the device first by setting a strong password for it before 
you can use the device.  

Activation via Batch Configuration Tool, and Activation via iVMS-4200 are supported. 
Here take activation via Batch Configuration Tool as example to introduce the device 
activation. Please refer to the user manual for the activation via iVMS-4200.  

Steps: 

1. Run the Batch Configuration Tool.  

 
Figure 8-1 Selecting Inactive Device 

2. Select an inactivated device and click the Activate button.  

 
Figure 8-2 Activation 
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3. Create a password, and confirm the password. 

STRONG PASSWORD RECOMMENDED– We highly recommend you create a 
strong password of your own choosing (Using a minimum of 8 
characters, including at least three of the following categories: 
upper case letters, lower case letters, numbers, and special 
characters.) in order to increase the security of your product. And 
we recommend you reset your password regularly, especially in the 

high security system, resetting the password monthly or weekly can better 
protect your product. 

4. Click the OK button to activate the device. 

 

 When the device is not activated, the basic operation and remote operation of device 
cannot be performed. 

 You can hold the Ctrl or Shift key to select multiple devices in the online devices, and 
click the Activate button to activate devices in batch. 

8.2 Editing Network Parameters 
Purpose: 

To operate and configure the device via LAN (Local Area Network), you need connect the 

device in the same subnet with your PC. You can edit network parameters via batch 

configuration tool, and iVMS-4200 software. Here take editing network parameters via 

batch configuration tool as example. 

Steps: 
1. Select an online activated device and click the Edit NET Parameters button.  

 
Figure 8-3 Clicking Edit NET Parameters Button 

2. Change the device IP address and gateway address to the same subnet with your 
computer.  

3. Enter the password and click the OK button to activate the network parameters 
modification. 
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Figure 8-4 Editing Network Parameters 

 

 The default port No. is 8000. 

 The default IP address of the indoor station is 192.0.0.64. 

 After editing the network parameters of device, you should add the devices to the 

device list again. 

 Enable DHCP, and the software can obtain network parameters for the device 

automatically.  

8.3 Adding Device 
Before you start: 

Make sure the device to be added has been activated. 

Purpose: 

For batch configuration tool software, you should add device to the software so as to 
configure the device remotely.  

The software provides 3 ways for adding the devices. You can add the active online 
devices within your subnet, add devices by IP address, and add devices by IP segment. 

8.3.1 Adding Online Device 
Before you start: 

Make sure the device to be added is in the same subnet with your computer. Otherwise, 
please edit network parameters first.  

Steps: 

1. Select an active online device or hold the Ctrl or Shift key to select multiple devices in 
the online devices list.  
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Figure 8-5 Online Devices Interface 

2. Click the  button to pop up the login dialog box. 

 
Figure 8-6 Login Dialog Box 

3. Enter the user name and password. 
4. Click the OK button to save the settings. 

 
 Only devices successfully logged in will be added to the device list for configuration. 

 If you add devices in batch, please make sure selected devices have the same user 
name and password. 

8.3.2 Adding by IP Address 

Purpose: 

You can add the device by entering IP address. 

Steps: 

1. Click the  button to pop up the adding devices dialog box. 

 
Figure 8-7 Adding Button  

2. Select IP Address in the adding mode drop-down list. 
3. Enter the IP address, and set the port No., user name and password of the device. 
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Figure 8-8 Adding by IP Address 

4. Click the OK button to add the device to the device list. 

 

 You cannot add the device(s) to the device list if the user name and password are not 

identical. 

 When you add devices by IP Address, IP Segment or Port No., the devices should be 

online devices. 

8.3.3 Adding by IP Segment 

Purpose: 

You can add many devices at once whose IP addresses are among the IP segment. 

Steps: 

1. Click the  button to pop up the adding devices dialog box. 

 
Figure 8-9 Adding Button  

2. Select IP Segment in the adding mode drop-down list. 

3. Set the Start IP Address and End IP Address.  

4. Enter port No., user name, and password.  
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Figure 8-10 Adding by IP Segment 

5. Click the OK button to search and add the devices whose IP addresses are within the 
range of the defined IP segment to the device list. 

8.4 Configuring Devices Remotely 

In the device list area, select a device and click  or  to enter 
the remote configuration interface. 

 
Figure 8-11 Remote Configuration 

 
Here we take the indoor station as an example, and the remote configuration of other 
devices can be referred. 

8.4.1 System 

Click the System button on the remote configuration interface to display the device 
information: Device Information, General, Time, System Maintenance, User, and RS485. 

Device Information 

Click the Device Information button to enter device basic information interface. You can 
view basic information (the device type, and serial No.), and version information of the 
device. 
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Figure 8-12 Device Information 

General 

Click the General button to enter device general parameters settings interface. You can 
view and edit the device name and device ID. 

 
Figure 8-13 General 

Time 

Steps: 

1. Click the Time button to enter the device time settings interface.  

 
Figure 8-14 Time Settings 

2. Select Time Zone or Enable NTP. 

 Time Zone 

1) Select a time zone from the drop-down list menu.  
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2) Click the Synchronization button.  

 NTP 

1) Check the checkbox of Enable NTP to enable NTP.  

2) Enter the server address, NTP port, and synchronization interval. 

 DST 

1) Check the checkbox of Enable DST to enable DST.  

2) Enter the start time and end time of DST, and set the DST bias. 

3. Click the Save button to save and realize the time settings.  

 
The default port No. is 123. 

System Maintenance 

Purpose: 

You can operate the system management and remote upgrading on the system 
maintenance interface.  

Steps: 

1. Click the System Maintenance button to enter the system maintenance interface.  

 
Figure 8-15 System Maintenance 

2. Click Reboot and the system reboot dialog box pops up. Click Yes to reboot the 
system. 

3. Click Restore Default Settings to restore the default parameters. 

4. Click Restore All to restore all parameters of device and reset the device to inactive 
status. 

5. Click Import Configuration File and the import file window pops up. Select the path 
of remote configuration files. Click Open to import the remote configuration file. The 
configuration file is imported and the device will reboot automatically. 
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Figure 8-16 Import File 

6. Click Export Configuration File and the export file window pops up. Select the saving 
path of remote configuration files and click Save to export the configuration file. 

 
Figure 8-17 Export File 

7. Click  to select the upgrade file and click Upgrade to remote upgrade the device. 
The process of remote upgrade will be displayed in the process bar. 
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Figure 8-18 Remote Upgrade 

 
 Click Restore Default Settings button, all default settings, excluding network 

parameters, will be restored.  

 Click Restore All button, all default settings, including network parameters, will be 
restored. The device will be reset to inactivated status. 

User 

Purpose: 

You can edit the password for logging in the device. 

Steps: 

1. Click the User button to enter the user information editing interface. 

 
Figure 8-19 Select User Name 

2. Select the user to edit and click the Modify button to enter the user parameter 
interface.  
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Figure 8-20 Modify User Information 

3. Enter the new password, and confirm it.  

4. Click the Save button to realize the editing of password.  

 
 The new password and confirm password should be identical. 

 After editing the password of device, click  button from the device list, the added 
device will not be there. You should add the device again with new password to 
operate the remote configuration. 

RS485 

Click the RS485 button to enter the RS485 setting interface. You can view and edit the 
RS485 parameters of the device. 

 
Figure 8-21 RS-485 



  

Video Intercom Indoor Station·User Manual 

60 

 

 
For indoor station and master station, there are 3 choices for the working mode: 
transparent channel, disable, and custom.  

8.4.2 Video Intercom 

Click the Video Intercom button on the remote configuration interface to enter the 
video intercom parameters settings: Device Number Configuration, Time Parameters, 
Password, Zone Configuration, IP Camera Information, and Volume Input and Output 
Configuration, and so on.  

Device ID Configuration 

Steps: 

1. Click the ID Configuration button to enter device ID configuration interface. 

  
Figure 8-22 Indoor Station Figure 8-23 Indoor Extension 

2. Select the device type from the drop-down list, and set the corresponding 
information.  

3. Click the Save button to enable the device number configuration. 

Time Parameters 

1. Click the Time Parameters button to enter time parameters settings interface. 

2. Configure the maximum ring duration, maximum live view time, and call forwarding 
time. 

3. Click the Save button. 

 
Figure 8-24 Time Parameters 

 
 Maximum ring duration is the maximum duration of indoor station when it is called 

without being received. The range of maximum ring duration varies from 30s to 60s. 
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 Maximum live view time is the maximum time of playing live view of the indoor 
station. The range of maximum live view time varies from 10s to 60s. 

 Call forwarding time refers to the ring duration limit beyond which the call is 
automatically forwarded to the mobile phone designated by the resident. The range 
of call forwarding time varies from 0s to 20s.  

 For indoor extension, it only requires setting the maximum live view time.  

Password 

Click the Password button to enter password changing interface. 

For indoor station, you can change the admin password, arm/disarm password, unlock 
password and duress code. 

 
Figure 8-25 Password Configuration 

 
For indoor extension, only admin password and arm/disarm password need to be 
configured. 

Volume Input and Output 

Step: 

1. Click Volume Input/Output button to enter the volume input and output interface. 

 
Figure 8-26 Volume Configuration 

2. Slide the slider to adjust the volume input and volume output. 

3. Click the Save button to enable the settings. 

Ring Import 

Click the Ring Import button to enter the ring configuration interface.  



  

Video Intercom Indoor Station·User Manual 

62 

 

 
Figure 8-27 Ringtone Configuration 

Click  to add the ring, and click  to delete the imported ring.  

 
 The ring to be imported should be in the wav format, and the size of the ring cannot 

be larger than 300k.  

 Up to 4 rings can be added. 

Zone  

1. Click the Zone Alarm button to enter zone settings interface. 

 
Figure 8-28 Zone Alarm 

2. Select a zone type from the drop-down list menu.  

3. Select an alarm mode from the drop-down list menu.  

4. Set the zone status: NO or NC.  

5. Set the entering delay, and exiting delay.  

6. Click the Save button to enable zone settings.  

 
 Six zone types are supported: Emergency Switch, Door Magnetic Switch, Smoke 

Detector, Active IR Detector, Passive IR Detector, and Combustible Gas Detector.  

 Three types of alarm mode are supported: Instant Alarm, 24H Alarm, and Delay 
Alarm.  
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 When the zone type is set to be Instant Alarm, only under arming mode, the indoor 
station will receive alarm message when the detector is triggered. Under disarming 
mode, it will not receive alarm message when the detector is triggered. 

 When the zone type is set to be 24H Alarm, the indoor station will receive alarm 
message when the detector is triggered no matter it is under arming mode or 
disarming mode. 

 When the zone type is set to be Delay Alarm, only under arming mode, the indoor 
station will receive alarm message when the detector is triggered. Under disarming 
mode, it will not receive alarm message when the detector is triggered. 

 After setting enter delay time, if the OK button is pressed within the enter delay time 
after the alarm, the alarm event will not be uploaded to the management center; if 
the OK button is not pressed within the enter delay time after the alarm, the alarm 
event will be uploaded to the management center. 

 The exit delay is the time between you enable the arming mode and the arming takes 
effect. 

IP Camera Information 

Purpose: 

You can add, delete and modify devices that can be added to the video intercom 
products, such as network IP cameras, door stations, doorphones, outer door stations, 
DVR/NVR/DVS, with two ways of getting stream: direct or URL. By exporting and 
importing the added device information, you can edit added devices parameters in 
batch.  

Adding IP Camera, DVR/NVR/DVS, and Doorphone 

Steps: 

1. Click the IP Camera Information button to enter IP camera information interface. 

 
Figure 8-29 IP Camera Information 

2. Click the Add button to pop up the device adding dialogue box.  
3. Select the device type from the drop-down list menu: IP Camera, DVR/NVR/DVS, 
and doorphone.  
4. Enter corresponding information (device name, IP address, port No., user name, 
password, etc.), and click the OK button. 
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Figure 8-30 Adding Devices 

 
Indoor extension does not support this function. 

Exporting and Importing Added Device Information 

Steps: 

1. Click the Export button to export the added device information file.  

 
Figure 8-31 Export Information 

2. Edit parameters of added devices in batch in the exported file.  
3. Click the Import button to pop up importing box, and open the edited added device 

information file.  
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Figure 8-32 Import Information 

8.4.3 Network 

Local Network Configuration 

Steps: 

1. Click the Local Network Configuration button to enter local network configuration 
interface.  

 
Figure 8-33 Local Network Parameters 

2. Enter the local IP address, subnet mask, gateway address, and port No..  

3. Click the Save button to enable the settings.  
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 The default port No. is 8000. 

 After editing the local network parameters of device, you should add the devices to 
the device list again. 

Linked Devices Network Configuration 

Purpose: 

In the linked devices network configuration interface, you can configure the network 
parameters of master stations, SIP servers and management centers of the same LAN. 
The devices can be linked to the door station and realize the linkage between these 
devices. 

Steps: 

1. Click the Linked Network Configuration button to enter linked network configuration 
interface.  

 
Figure 8-34 Linked Network Configuration 

2. Enter the master station IP address, (main) door station IP address, SIP server IP 
address, management center IP address, and doorphone IP address.  

3. Select the main door station type from the drop-down list. 

4. Click the Save button to enable the settings.  

 
 After adding master station IP Address, the linkage between indoor station and 

master station can be realized. 

 After adding the door station IP Address, the video intercom between indoor stations 
of same building can be realized. 

 After adding SIP Server Address IP, the video intercom of same community: video 
intercom between indoor stations of different building, calling indoor station from 
outer door station and video intercom between management center and indoors. 

 After adding management center IP Address, the events can be uploaded to the 
management center. 
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 For indoor extension, only parameter about the main indoor station should be 
configured.  

8.5 Video Intercom Device Set-up Tool 

Purpose: 

You can assign the device to the community, activate and set the device, and configure 
the network parameters and linked network parameters for the device by using the 
video intercom device set-up tool.  

In the device list area, click  to enter the video intercom device set-up tool.  

 
Figure 8-35 Video Device Set-up Tool 

8.5.1 Setting a Community Structure 

Set a community structure in the video intercom device set-up tool first, based on the 
real community situation, and then assign devices to the community accordingly. 

 
Figure 8-36 Setting a Community Structure 
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8.5.2 Setting Indoor Station 

Purpose: 

You can activate the online indoor station, and configure the room No. for the online 

indoor station. 

Steps: 

1. Press the Indoor Station tab to switch to the indoor station configuration interface.  

 
Figure 8-37 Setting Indoor Station 

2. Select a community, and enter the indoor station start IP address, and then click the 
Calculate button to generate the indoor station end IP address and indoor station 
room No. (like 1-1-1-1-2) automatically. 

3. Set the main door station parameters: door station type (door station for unit, or door 
station for villa), main door station IP address. 

4. Set the linked network parameters for the indoor station: SIP IP address, master 
station IP address, center IP address, center port No., subnet mask, and gateway 
address.  

5. Select an online door station, enter the login password, and click the Set button. 
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 The indoor station configured successfully will be listed in the configured device area. 

At the same time, the next indoor station can be easily configured by selecting 

another indoor station in the online device area and clicking the Set button. 

 For the login password, if the indoor station has been activated, enter the activation 

password here. If the indoor station is not activated, create a login password here, 

and the indoor station will be activated simultaneously.  

 When the device is successfully configured, it prompts the note: Configuring main 

door station parameters succeeded. 

8.6 Batch Upgrading 

In the device list area, click  to enter the batch upgrading interface. 

 
Figure 8-38 Batch Upgrading 

8.6.1 Adding Devices for Upgrading 

You should add the device to the batch upgrading tool first before upgrading the device. 
There are 2 ways to add the device: adding online device, and adding by IP address/IP 
segment. 

Adding Online Device 

Steps: 
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1. In the batch upgrading interface, click the  to open the online device 
window.  

 
Figure 8-39 Login 

2. Select a device, enter the user name and password, and click the Login Device button. 
3. Click the Add Device button, and the device is added to the batch upgrading tool. 

 
Figure 8-40 Online Devices 
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Adding by IP Address/IP Segment 

Steps:  

1. Click the Manual button to open the device adding window.  
2. Enter the corresponding information (IP address, user name, password, start IP 

address, end IP address). 
3. Click the Add button. 

 
Figure 8-41 Adding by IP Address/IP Segment 

8.6.2 Upgrading Devices 

There are 2 upgrading modes available: upgrading by file, and online upgrading. 

Upgrading by File 

Upgrading by File: You upgrade the device or devices via the local upgrade files.  

Steps: 

1. Select a device or multiple devices, and select “Upgrade by File” as the upgrading 
mode.  

2. Click  to pop up the window for opening the upgrading file.  
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Figure 8-42 Upgrade by File 

3. Open the upgrading file, and click the Upgrade button.  

Online Upgrading 

Online Upgrading: The batch upgrading tool will search the latest upgrading file for the 
device automatically. You upgrade the device or devices via the local upgrade files.  

Steps: 

1. Select a device or multiple devices, and select “Online Upgrade” as the upgrading 
mode.  

2. Click the Download button. Click the Upgrade button after the online upgrading file 
has been wholly downloaded. 
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9 Remote Operation via iVMS-4200 
The Video Intercom module provides remote control and configuration on video 
intercom products via the iVMS-4200 client software. 

Before remote configure and control the video intercom, you are required to add the 
device to the software first. Refer to 9.2 Device Management. 

For remote configuration of video intercom device via the iVMS-4200 client software, 
refer to 9.3 Configuring Devices Remotely via iVMS-4200. 

For the picture storage on storage server, refer to 9.4 Picture Storage. 

For remote control of video intercom devices, please refer to 9.5 Video Intercom 
Configuration. 

9.1 System Configuration 
Purpose: 

You can configure the video intercom parameters accordingly. 

Steps: 

1. Open the System Configuration page. 

Path: Control Panel -> Maintenance and Management -> System Configuration -> 
Video Intercom. 

2. Click the Video Intercom tab to enter the Video Intercom Settings interface. 

3. Input the required information. 

Ringtone: Click the icon  and select the audio file from the local path for the 

ringtone of indoor station. Optionally, you can click the icon  for a testing of the 
audio file. 

Max. Ring Duration: Input the maximum duration of the ringtone, ranging from 15 
seconds to 60 seconds. 

Max. Speaking Duration with Indoor Station: Input the maximum duration of 
speaking with the indoor station, ranging from 120 seconds to 600 seconds. 

Max. Speaking Duration with Door Station: Input the maximum duration of speaking 
with the door station, ranging from 90 seconds to 120 seconds. 

Card Reader Type: Select the card reader to issue cards.  

4. Click Save to save the settings. 
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Figure 9-1 System Configuration Interface 

9.2 Device Management 
Purpose: 

Device management includes device activation, adding device, editing device, and 
deleting device, and so on.  

After running the iVMS-4200, video intercom devices should be added to the client 
software for remote configuration and management. 

9.2.1 Adding Video Intercom Devices 

 
 You can add at most 512 indoor stations and master stations in total to the 

iVMS-4200, and add at most 16 door stations to the iVMS-4200. 

 For video intercom devices, you are required to create the password to activate them 
before they can be added to the software and work properly. For device activation via 
creating password, please refer User Manual of iVMS-4200 (Video Intercom) V2.4.2 in 
the disk for detail steps. 

 You can add online video intercom devices, and add them manually. Here take adding 
online video intercom devices as example. For adding video intercom devices 
manually, please refer User Manual of iVMS-4200 (Video Intercom) V2.4.2 in the disk 
for detail steps. 

Steps: 
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1. Click the  icon on the control panel, or click Tools->Device Management to 
open the Device Management page. 

2. Click the Server tab. 

To add indoor station or master station: 

1) Click Add New Device Type to enter add new device type interface. 

Select Indoor Station/Master Station and click OK. 

 
Figure 9-2 Adding New Device Type 

2) In the Server tab, Video Intercom Device will display, select Video Intercom 
Device and add indoor station and master station. 

To add door station: 

In the Server tab, select Encoding Device/Outdoor Device and add door 
station. 

3. The active online devices in the same local subnet with the client software will be 
displayed on the Online Device area. You can click the Refresh Every 60s button to 
refresh the information of the online devices. 

 
Figure 9-3 Online Device 

 
To add online devices to the software, you are required to change the device IP 
address to the same subnet with your computer first.  
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4. Select the devices to be added from the list. 

5. Click Add to Client to open the device adding dialog box. 

6. Input the required information. 

Nickname: Edit a name for the device as you want. 

Address: Input the device’s IP address. The IP address of the device is obtained 
automatically in this adding mode. 

Port: Input the device port No.. The default value is 8000. 

User Name: Input the device user name. By default, the user name is admin. 

Password: Input the device password. By default, the password is 12345. 

7. Optionally, you can check the checkbox Export to Group to create a group by the 
device name. All the channels of the device will be imported to the corresponding 
group by default. 

 
iVMS-4200 also provides a method to add the offline devices. Check the checkbox 
Add Offline Device, input the required information and the device channel number 
and alarm input number, and then click Add. When the offline device comes online, 
the software will connect it automatically. 

8. Click Add to add the device. 

 
Figure 9-4 Adding Device by IP/Domain 

 
Add Multiple Online Devices 
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If you want to add multiple online devices to the client software, click and hold Ctrl key 
to select multiple devices, and click Add to Client to open the device adding dialog box. 
In the pop-up message box, enter the user name and password for the devices to be 
added. 

Add All the Online Devices 

If you want to add all the online devices to the client software, click Add All and click OK 
in the pop-up message box. Then enter the user name and password for the devices to 
be added. 

9.2.2 Modifying Network Information 

Select the device from the online list, click Modify Netinfo, and then you can modify the 
network information of the selected device. 

 
Figure 9-5 Modifying Network Parameter 

 
You should enter the admin password of the device in the Password field of the pop-up 
window to modify the parameters. 

9.2.3 Resetting Password 

According to the different video intercom devices, the software provides two different 
methods for restoring the default password or resetting the password. 

Select the device from the online device list, click Reset Password. 

Option 1: 
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If the window with import file button, key importing mode drop-down list, password 
and confirm password field pops up, follow the steps below to reset the password: 

 
This option is available to door stations. 

 
Figure 9-6 Resetting Password (Option 1) 

1. Click Export to save the device file on your computer. 

2. Send the file to our technical engineers. 

3. Our technical engineer will send you a file to you. After receiving a file from the 
technical engineer, select Import File from Key Importing Mode drop-down list and 

click  to import the file. 

4. Input new password in text fields of Password and Confirm Password. 

5. Click OK to reset the password. 

 

STRONG PASSWORD RECOMMENDED– We highly recommend you create a strong 
password of your own choosing (Using a minimum of 8 characters, 
including at least three of the following categories: upper case letters, 
lower case letters, numbers, and special characters.) in order to 
increase the security of your product. And we recommend you reset 
your password regularly, especially in the high security system, 

resetting the password monthly or weekly can better protect your product. 

 

Option 2: 
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If the window with import file and export file buttons, password and confirm password 
field pops up, follow the steps below to reset the password: 

Note: This option is available to indoor stations and master stations. 

 
Figure 9-7 Resetting Password (Option 2) 

1. Click Export to save the device file on your computer. 

2. Send the file to our technical engineers. 

3. Click Import and select the file received from the technical engineer. 

4. Input new password in text fields of Password and Confirm Password. 

5. Click OK to reset the password. 

 

STRONG PASSWORD RECOMMENDED– We highly recommend you create a strong 
password of your own choosing (Using a minimum of 8 characters, 
including at least three of the following categories: upper case letters, 
lower case letters, numbers, and special characters.) in order to 
increase the security of your product. And we recommend you reset 
your password regularly, especially in the high security system, 

resetting the password monthly or weekly can better protect your product. 

 

9.3 Configuring Devices Remotely via iVMS-4200 
Configuring devices remotely via iVMS-4200 is the same with that via Batch 
Configuration Tool, please refer 8.4 Configuring Devices Remotely for detail steps.  
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9.4 Picture Storage 
When the video intercom device is under armed status, it will capture the picture 
automatically after unlocking the door. The captured picture can be uploaded and stored 
in the storage server.  

When starting the live view of door station via iVMS-4200, you can capture the live view 
picture. The captured picture can be uploaded and stored in the storage server. 

  
 This function is only available to door stations. 

 You are required to add storage server to the iVMS-4200, and format the HDDs first 
before uploading and storing captured pictures. 

9.4.1 Adding Storage Server 

Before you start: 

The storage server application software needs to be installed and it is packed in the 
iVMS-4200 software package. When installing the iVMS-4200, check the checkbox of 
Storage Server to enable the installation of storage server. 

1. Click the icon  on the desktop to run the storage server. 
2. Open the Device Management page and click the Server tab.  
3. Click Add New Device Type, select Storage Server and click OK. 

 
Figure 9-8 Adding Storage Server Type 
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4. Click Storage Server on the list to enter the Storage Server Adding interface. 

 
For adding the storage server, please refer to 9.2.1 Adding Video Intercom Devices, or 
User Manual of iVMS-4200 (Video Intercom) V2.4.2 in the disk. 

9.4.2 Formatting the HDDs 

The HDDs of the storage server need to be formatted for the captured picture storage. 

Steps: 

1. Select the added storage server from the list and click Remote Config. 
2. Click Storage->General to enter the HDD Formatting interface. 
3. Select the HDD from the list and click Format. You can check the formatting process 

from the process bar and the status of the formatted HDD changes from Unformatted 
to Normal Status. 

 
Figure 9-9 Formatting HDDs 

 
Formatting the HDDs is to pre-allocate the disk space for storage and the original data of 
the formatted HDDs will be deleted. 
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9.4.3 Configuring Storage Server Picture Storage 

Before you start: 

The storage server needs to be added to the client software and the HDDs need to be 
formatted for the captured pictures storage. 

Steps: 

1. Open the Record Schedule page. 
2. Select the camera from the Camera Group list. 
3. Select the storage server from the Storage Server drop-down list. 

 
You can click Storage Server Management to add, edit or delete the storage server. 

4. Check the checkbox of Picture Storage to store the alarm pictures of the camera 
when event occurs.  

 
Figure 9-10 Setting Storage Server 

5. Click Set Quota to enter the HDD management interface of the storage server. You 
can set the corresponding quota ratio for captured picture information. 
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Figure 9-11 Setting Quota 

Example: If you set the picture quota as 60%, then the 60% of the storage space 
can be used for storing the captured pictures. 

6. Click Save to save the settings. 

9.5 Video Intercom Configuration 

Click the icon  on the control panel of iVMS-4200 or click View -> Video 
Intercom to open the Video Intercom page. On the Video Intercom page, you can 
control video intercom devices remotely. There are 4 modules on the Video Intercom 
page: 

Video Intercom: Start visual communication with door stations, and manage 
incoming calls from indoor stations and door stations and master stations. Refer 
9.5.2 Video Intercom for detail steps. 

Group Management: Construct virtual communities according to the real 
community situations, and assign door stations and indoor stations to the 
community accordingly. Refer 9.5.1 Group Management for detail steps. 

 
You should manage groups first before starting the visual communication with 
indoor stations or door stations. 
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Card Management: Add unauthorized cards to the iVMS-4200, and issue card to 
the door station via the iVMS-4200. Refer 9.5.3 Card Management for detail steps. 

 
Once you issue cards via the iVMS-4200, the card issuing function of the 
corresponding door station will be disabled automatically. 

Notice Management: Send information to indoor stations, search information, 
search call logs, and search unlocking logs. Refer 9.5.4 Notice Management for 
detail steps. 

 
Figure 9-12 Intercom Interface 

9.5.1 Group Management 

Purpose: 

You can add groups to community, outer door station, or other, and assign devices to 
each group.  

Enter Control Panel -> Video Intercom -> Group Management to add, edit, and delete 
groups. Three group types can be selected: community, outer door station and other.  

Adding Group 

1. Click the Group Management tab to enter the group management interface. 
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Figure 9-13 Adding Group 

2. Click  to pop up group adding window, and input the corresponding information 
accordingly. 

 Select Community as group type, and then Input the Community No., 
building No., and Unit No. to set the community structure, as shown in the 
figure below. 

 
Figure 9-14 Adding Community 

 Select Outer Door Station as group type, and then input the outer door 
station No. (Range: 1 to 9) to set the outer door station, as shown in the 
figure below. 
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Figure 9-15 Adding Outer Door Station 

 Select Other as group type, and then input the group name. 

 
Figure 9-16 Adding Other 

For example: You can name the group as administrator, entrance guard and cleaning 
staff, etc. 

 
When selecting Other as the group type, you can set different groups for staff other 
than residents, such as administrator, security guard and cleaning staff, etc., and you 
can assign cards to these staff and configure different permissions to them.  

3. Click OK to complete group adding.  
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Assigning IP Devices to Group  

After adding groups to Community, Outer Door Station, or Other, you should assign 
devices to the group.  

For example: You should assign indoor stations and door stations to the group 1-1-1 in 
Community.  

1. Click Add to enter the Add Resident Interface and the video intercom devices added 
to the client software will be listed, as shown in the figure below. 

 
Figure 9-17 Adding Resident 

2. Check the checkbox of device. 

Indoor Station: set a Room No. for the indoor station.  

Door Station: set a No. for the door station.  

3. Click OK to save the settings.  

Assigning Analog Devices to Group  

 
When assigning analog devices to group, only analog indoor stations are supported.  

1. Click Add Analog to pop up analog device adding window. You can add analog devices 
singlly or in batch.  
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 Adding Devices in Batch: Enter the start floor and end floor, and set the room 
numbers.  

 
Figure 9-18 Adding Devices in Batch 

 
Room Numbers here refers to the room numbers in each floor. 

 Adding Devices Singlly: Enter the room No..  

 
Figure 9-19 Adding Device Singly 

 
The room No. format is like 101. 

2. Click OK to save the settings. 
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Modifying Device Information 

1. Select an added device. 
2. Click Modify to enter the device modifying interface.  

 
Figure 9-20 Modifying Device Information 

3. Click OK to complete the device modifying operation.  

Deleting Device 

1. Select an added device. 
2. Click Remove to pop up a dialog box.  

 
Figure 9-21 Information 

3. Click OK to complete the group deleting operation. 

9.5.2 Video Intercom 

Receiving Call from Indoor Station 

Purpose: 

When the indoor station has been added to the client software, you can call iVMS-4200 
via indoor station.  

Before you start: 

 Make sure the indoor station has been added to the iVMS-4200 client software.  
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 Make sure the SIP server IP address of the indoor station is not configured (or 
abnormal). 

Steps: 

Press Center on the main interface of the indoor station. 

 
Figure 9-22 Calling from Indoor Station 

  
 When the SIP server IP of the indoor station is configured, press Center on the main 

interface of the indoor station to call the master station instead of iVMS-4200. 

 Click Unlock to unlock the building or villa door via iVMS-4200, no matter whether 
answering the call from indoor station or not. 

 Click Answer to answer the call from indoor station.  

 Click Hang Up to end the call from indoor station. 

Calling Indoor Station via iVMS-4200 

Enter Control Panel-> Video Intercom-> Video Intercom to enter the Video Intercom 
page.  

The software provides three different methods for calling indoor station.  

Option 1: Calling Resident (Indoor Station) by Room No. 

1. Input the room No. of the indoor station in the dial keyboard on the right. 
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Figure 9-23 Calling Indoor Station (Option 1) 

 
You should enter the Room No. in the correct format. For example, 1-2-3-101 
refers to Room 101, Unit 2, Building 3, Community 1.  

2. Click Call to start video call with the indoor station. 

Option 2: Calling Resident (Indoor Station) from Group 

1. Select the community from the groups on the left. 
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Figure 9-24 Calling Indoor Station (Option 2) 

2. Double click the added resident from the resident list to call the resident. 

Option 3: Calling Resident (Indoor Station) from Call Log 

1. Click the dial log on the below and select the log type to enter the dial log interface. 

 
Figure 9-25 Calling Indoor Station (Option 3) 
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2. Click Call from the call logs to start video call with the indoor station. 

Call Log 

On the Video Intercom tab page, there are four types of call logs you can search: All, 
Dialed, Received, and Missed. 

On the dial log area, you can view detail information of the dialog, and click Call to start 
the audiovisual call with the indoor station.  

Click  to clear all logs in the list (optional). 

9.5.3 Card Management 

Purpose: 

You can add unauthorized cards to the community and then you can assign the cards to 
the corresponding indoor station and door stations.  

For example, if there are 3 residents living in Room 401, you can assign 3 cards to No. 
401 Indoor Station.  

For each indoor station, you can assign multiple cards, and you can assign these cards to 
the door station in the same building. 

Note: Indoor extension does not support Card Management. 

Before you start: 

Make sure the indoor station and door station have been added to the iVMS-4200 client 
software.  

Steps: 

Click Video Intercom -> Card Management to enter the card management page.  
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Figure 9-26 Card Management Interface 

Adding Card 

Steps: 

1. Click Unauthorized Card -> Add Card to pop up card adding window. 
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Figure 9-27 Adding Cards in Batch 

2. Select card adding mode and card type.  

 
Two types of card are available. Resident Card is used by residents living in the 
community, and Other Card is used by visitors (guest, serviceman, etc.) in the 
community. 

 If you add card in batch, please set the start card No. and the end card No.. 

 If you add card singly, please enter the card No.. 

 If you add card via card reader, please swipe the card in the card reader, and the 
corresponding card No. will be shown automatically in the Card No. textbox. 

3. Click OK to accomplish carding adding operation.  

 
 Click Delete All to delete all cards added in iVMS-4200. 

 Select one or multiple cards, and click Delete Card to delete selected cards added in 
iVMS-4200. 

 Card Encrypt is only available to cards added via card reader. Enabling Card Encrypt 
can improve the card security to prevent it from being copied. But the same time, the 
default key of all the available sectors of the card is modified. 

Issuing Card 

Click Issue Card to pop up card issuing window. 
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Figure 9-28 Issuing Card 

Issuing Resident Cards 

Steps: 

1. Select Community from the organization list (like 1-1-1) and the indoor stations of the 
community will be listed in the resident list. 

 
Figure 9-29 Clicking Card Selection 
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2. Click Card Selection to pop up card selection window where unauthorized resident 
cards are listed. 

 
Figure 9-30 Selecting Cards 

3. Check the checkboxes of the cards or enter the card No. in the filter textbox you need 
to assign to the indoor station, and check the checkbox of door stations, doorphones 
and outer door stations. 

 
Only resident cards can be assigned to indoor stations. 

4. Click Issue Card to complete the card issuing operation. 
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Figure 9-31 Displaying Card Issued 

 
After issuing resident cards to the indoor station, the card No. will also be listed in the 
resident list. 

Issuing Other Cards 

Steps: 

1. Select Other from the group list (like Cleaning Staff). 

 
Figure 9-32 Issuing Other Card 
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2. Click Card Selection to pop up card selection window where unauthorized other cards 
are listed. 

 
Figure 9-33 Selecting Cards 

3. Check the checkboxes of the cards or enter the card No. in the filter textbox you need 
to assign to the person, and check the checkbox of door stations, doorphones and 
outer door stations. 

4. Click Issue Card to complete the card issuing operation. 

 
Figure 9-34 Displaying Card Issued 
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After issuing other cards to the person, the card No. will also be listed in the resident 
list page. 

Canceling Cards 

When canceling cards, cards that have been issued will be reset to authorized ones. Via 
iVMS-4200, there are two ways to cancel the cards which have been issued.  

Option 1:  

Steps: 

1. Select Community from the organization list (like 1-1-1) and the indoor stations of the 
community will be listed in the resident list. 

 
Figure 9-35 Card Selection Interface 

2. Click Card Selection to pop up card selection window where normal cards and 
unauthorized resident cards are listed. 
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Figure 9-36 Selecting Cards 

3. Check the checkboxes of the cards that has been issued (normal cards). 

4. Click Issue Card to complete the card canceling operation. 

Option 2:  

On the card issuing interface, check the checkboxes of Room No. (for resident card) or 
Name (for other card), click Cancel Card to cancel all card issued to the device.  

 
 Through Option 1, you can cancel card from single or certain door stations. 

 Through Option 2, you will cancel all issued cards at a time. 

Normal Card 

Click Normal Card to display normal card list. After issuing cards, the issued cards will be 
listed in the normal card list, as shown in the figure below. 
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Figure 9-37 Normal Cards Interface 

Batch Importing Unauthorized Cards 

Steps: 

1. Click Batch Import to enter the batch import interface, as shown in the figure below. 

 
Figure 9-38 Importing File 

2. Click Export Template to export the template of the batch import file. 

3. Fill in the template of the batch import file and save it. 

4. Click  to select the batch import file and click Open. 
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5. Click OK to start importing the batch import file. 

Batch Exporting Unauthorized Cards 

Steps: 

1. After adding unauthorized cards, and click Batch Export. 

2. Select the saving file path and click Save. 

3. After batch exporting the unauthorized cards, the excel will be generated in the saving 
directory. 

9.5.4 Notice Management 

Creating Notice Information 

Purpose: 

You can create notice information and send it to residents (indoor stations). 

Steps: 

1. Click Notice -> Create Notice Information to enter the notice information creating 
page. 

 
Figure 9-39 Notice Creation Interface 

2. Click Send To to pop up the residents (indoor stations) selection window. Check the 
checkboxes of indoor stations you want to send information to, and click OK. 
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Figure 9-40 Selecting Residents 

3. Enter the subject, set the information type, and add the picture (optional).  

4. Enter the information and click Send to send the notice. 

 
 For IP indoor stations, no more than 63 characters (including space) can be input in 

the field of subject. For analog indoor stations, no more than 20 characters (including 
space) can be input in the field of subject. 

 For IP indoor stations, no more than 1023 characters (including space) can be input in 
the field of information. For analog indoor stations, no more than 300 characters 
(including space) can be input in the field of information. 

 Only picture with size smaller than 512KB and with format of jpg. can be added to the 
notice, and no more than 6 pictures can be added to the same notice information. 

 Analog indoor stations do not support receiving pictures.  

Querying Notice Information 

Purpose: 

You can search the notice information send to residents. 

Steps: 

1. Select Query Notice Information to enter query notice information interface. 

2. Select the info type, input the subject, recipient, and set the start time and end time. 
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Figure 9-41 Notice Interface 

3. Click Query to search the notice information. 

4. Click  to view the detailed information of selected notice. You can resend the 
notice information failed to be received or unread by residents. 

 
Figure 9-42 Message Details 

5. Click Export to export the notice information. 
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Querying Call Logs 

Steps: 

1. Click Query Call Logs to enter the call log querying page. 

2. Select the calling status, device type, and set the start time and end time, and click 
Query to search the call log. 

 
Figure 9-43 Call Log Interface 

3. Click Export to export the call logs as an excel file. 

Querying Unlocking Log 

Steps: 

1. Click Query Unlocking Logs to enter the unlocking log querying page. 

2. Select the unlocking type, device type, and set the start time and end time, and click 
Query. 
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Figure 9-44 Unlocking Log Interface 

3. Click Export to export the unlocking logs as an excel file. 

9.6 Device Arming Control 
Steps: 

1. Select Tool->Device Arming Control to pop up device arming control window. 

 

Figure 9-45 Tool Bar 
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2. Set the arming status of the device as armed, and the alarm information will be auto 
uploaded to the client software when alarm occurs. 

 
Figure 9-46 Device Arming Control 

 
Figure 9-47 Alarm Events 

 
After adding the device to the client software, it will be armed automatically. 
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10 Accessing via Hik-Connect Mobile Client 
Software 

 

 The Hik-Connect mobile client software supports the iOS system and Android system 

both.  

 The basic operations of the client software are similar on the iOS system and on the 

Android system. Here we take operations on the iOS system as example.  

10.1 Installing Software 

10.1.1 Installing Software (iOS) 

Steps: 

1. Log in the App Store.  
2. Enter the key words Hik-Connect to search the mobile client software.  
3. Download and install the software to your iPhone. 

4. After installing the software, tap  to run it.  

10.1.2 Installing Software (Android) 

Step: 

1. Log onto the Google Play.  
2. Enter the key words Hik-Connect to search the mobile client software.  
3. Download and install the software to your phone.  

4. After installing the software, tap  to run it.  

 

To uninstall the software, tab and hold the software icon  until the icon turns to 

, and tab the delete icon on the upper-left corner to delete the software.  

10.2 Registering Software 
Purpose: 
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You should register the software first before logging in the software.  

Two ways of registration are available: Registration via Telephone No., and Registration 
via E-Mail Address. Here we take Registration via Telephone No. as example to introduce 
registering an account in the software.  

Steps: 

1. Tap the icon  to run the software, and tap Register an Account to enter 
registration mode selection interface.  

 
Figure 10-1 Main Interface 

 

 
Figure 10-2 Selecting Registration Mode 

2. Tap Terms of Service, and check the checkbox of Read and Agree if you agree the 
Agreement.  

3. Tap Register by Mobile Phone Number, to enter the region selection interface.  
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Figure 10-3 Selecting Region 

 

 
Figure 10-4 Entering Phone No. 

4. Select a target region, enter a valid mobile phone No., and tap the Get Verification 
Code button. The verification code will be sent to your phone.  

 
Figure 10-5 Entering Code 

 

 
Figure 10-6 Setting Account 

5. Enter the received verification code, and tap the Next button to enter the account 
creating interface. On the account creating interface, enter a user name, a password, 
a confirm password, and tap the Finish button to complete account registration.  
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10.3 Logging in Software 
Steps: 

1. Tap the icon  to run the software.  
2. Enter the user name/e-mail address, and enter the password.  
3. Tap the Login button to log in the software.  

 

 If you want to login via mobile phone No., please tap Login with mobile phone 

number. 

 If you forget the password, please tap Forgot Password to find the password.  

10.4 Adding Device 
Two ways of adding device are available: Adding Device by Scanning QR Code, and 
Adding Device by Inputting Device Serial No..  

10.4.1 Adding Device via QR Code  

Steps: 

1. On the Home screen, tap the icon . 
2. Scan the device QR code to pop up the device information page, and tap the Add 

button. 

 
Figure 10-7 Scanning QR Code 

 

 
Figure 10-8 Device Result 

3. Enter the device verification code, tap the OK button, and finish the device adding. 
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Figure 10-9 Entering Code 

 

 
Figure 10-10 Device Added 

10.4.2 Adding Device via Serial No. 

Steps: 

1. On the Home screen, tap the icon , and tap the icon .  
2. Enter the serial No. of the device to pop up the device information page, and tap the 

Add button. 

 
Figure 10-11 Scanning QR Code 

 

 
Figure 10-12 Device Result 

3. Enter the device verification code, tap the OK button, and finish the device adding. 
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Figure 10-13 Entering Code 

 

 
Figure 10-14 Device Added 

 
 The serial No. of the device is on the label stuck on the rear panel of the device.  

 The default device verification code is ABCDEF.  

10.5 Live View and Remote Unlocking 
After adding the device, go the Home page, and tap a camera to enter the live view 
interface.  

 
Figure 10-15 Live View Page 
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On the live view page, you can control the intercom device remotely. See the following 
table in detail.  

Table 10-1 Icon Description 

Keys Description 

 
Enable the live view. 

 
Disable the live view. 

 
Enable/disable the audio. 

 Switch to the full-screen mode. 

 
Switch to the 4-screen mode. 

 
Zoom in. 

 

Remote unlock. 

 

Capture the live view image. 

 

Enable/disable recording. 
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Appendix 

Installation Notice 
While installing the indoor station, please make sure that the distance between any two 

devices is far as possible to avoid the howling and echo. The distance between two 

devices is recommended to be more than 10 meters. 

 
Here the devices refer to indoor station, outdoor station and master station. 

Wiring Cables 

Cable Specification 

Power Cord of Door Station RVV 2*1.0 

Network Cable of Door Station UTP-five Categories 

Door Lock Wiring (With Door Magnetic) RVV 4*1.0 

Door Lock Wiring (Without Door Magnetic) RVV 2*1.0 

Exit Button Wiring RVV 2*0.5 

External Card Reader Wiring RVVP 4*0.75 
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